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Agenda

“ Overview of Database Recovery Process
» What is Recovery? |:|[|
» IBM Database Recovery Techniques

“IMS Backup and Recovery Capabilities
» Log Management, DBRC
» Backup, Recovery, Backout and Restart processes

“ Backup and Recovery Scenarios
» IMS Online
» IMS Batch

» Disaster Recovery

ion critical applications and your production

ure that availability and integrity work tog

ill describe how backup and recovery tools
backup and recovery scenarios.
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What is Recovery ?

“ Restoring a failed system to normal
» Restoring with Data Integrity
» Restoring to synchronization points

Points of Consistency are application syncpoints
Database protocols assure logs and DB are synchronized

“ Recovery of Application Programs Errors

“ Restoration of a damaged database due to a failure
» Hardware, or software failure

Full Recovery

» Application failure
» Application logic failure Timestamp Recovery

Wrong update Point-In-Time Recovery
Update applied at the wrong time

Disaster Recovery
IMS and DB2 Coordinated Recovery
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Restoring a failed system to normal

“ System Checkpoints
» For IMS restart

» Taken periodically — Manually or automatically

CPLOG parameter — changed by /CHA CPLOG
/CHECKPOINT command

“ Application Synchronization Point

» Safe Point of DB Consistency

» Where work is assumed to be complete (UOW complete)
Database updates are committed.
Log records are written.
Resource Manager Locks are released.
Output Messages are sent.

» Point for future application recovery

Automatically taken for each new transaction in MPP
Explicit checkpoint call required for BMP




Recovery of Application Programs Errors
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“ Error Detected at execution time

4

»
»
»
»

Stop execution, cancel program

Backout updates (if not automatic)

Correct program error

Restart the application If Checkpoint/Restart included
or reprocess the transaction

“ Error Detected after commit time

4

4
»

» Recovery to an earlier time and reprocessing transactions may be the best
solution

Data may have been reused

Work may span several Resource Managers
No backout possible

Manual recovery may be complicated
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Restoration of a damaged database due to failure

“ Hardware
» System Crash
» Media Failure
“ Software
» Operating System Failure
» IMS Subsystem Failure
“ Application Logic

» Logic Error (wrong field, arithmetic
operation error, etc)

» Omitted processing
» Extra processing

Some reasons

A DLI batch update job fails after
making at least one database update,
and Batch backout fails.

A failure has occurred on a physical
DASD device.

A failure has occurred in a database
recovery utility.

A failure of dynamic backout or
batch backout utility has occurred
(IMS DB only).

An IMS or DB2 online system failure
and emergency restart has not been
completed.

Application Error - invalid updates
have occurred
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IMS Database Recovery Techniques

“ Full Database Recovery
» Recover all database updates to last available log record

» Uses: Last image copy + logs + backout as needed
» Applies to Disaster Recovery when ICs and logs are on the remote site

’(‘ >
-+ | upp| upp| cmT| uPD| UPD UPD:| UP:D| -+ | RECOVERY | 4 | BACKOUT | = m

“ Full Database Recovery with data sharing
» Multiple concurrent logs

» Merge updates on logs using Change Accumulation (CA)

No CA and backout needed if using IMS ORS or DRF Tools
» Uses: Last image copy + change accumulation + 2 backouts
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IMS Database Recovery Techniques ...

“ Timestamp Recovery
» Recover database updates to an earlier state (time) than the last log record
Uses: Earlier image copy + some logs data sets
» Recovery point (RP) Constraints

No subsystem has the database open for update at recovery time
Change Accumulation may be required if Data Sharing
—Unless using IMS ORS or DRF Tool

@ UPD|] UPD| UPD| CMT UPD] UPD| UPD] CMT] UPD| UPD| UPD| UPD| CMT| UPD

RP RP RP RP
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IMS Database Recovery Techniques ...

“ Timestamp Recovery with data sharing
» Multiple updaters

» Multiple logs
Change Accumulation needed
» Multiple ALLOC records
» Recovery point must be created on each IMS

Requires longer data outage
/DBR database on all systems before /START on any system
—All ALLOC records must be closed at the same time

RE

_ | upo| cmr| urp| urp| uprp| upPp| cmT| uPD

IMS1 | upD| uPD| UPD| CMT

UPD| UPD| UPD| CMT] UPD| UPD| UPD

IMS2 | upp| upp| uprp| upp| upPD| cmT}

Longer Can only recover to time when DBDS
was not allocated to any IMS
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IMS Database Recovery Techniques ...

“ Point-In-Time Recovery (PITR)
» Recovery to a timestamp other than a RP (in the middle of an UOW)

» Not a DBRC supported Recovery Point when using IMS standard Database
Recovery utility

» With Online Recovery Service (ORS) Tool or Database Recovery Facility
(DRF) Tool

Capability to recover IMS DBs to any timestamp, even if in the middle of UOW
Only committed updates applied

» Use IBM Application Recovery for IMS and DB2 Tool to create DBRC
Supported RP

To be able to use Timestamp Recovery instead of PITR
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IMS / DB2 Coordinated Timestamp Recovery

“IMS / DB2 Coordinated Timestamp Recovery
» Must recover IMS and DB2 to same consistent state (time)
Terminology: IMS Time stamp recovery, DB2 PIT recovery
» IMS and DB2 produce independent log streams
No utility to trim logs to a consistent state
» Must establish concurrent recovery points

Use a DB2 quiesce point and an IMS /DBR command
Use a DB2 quiesce point with IMS ORS/DRF tool (PITR)
Use IBM Application Recovery for IMS and DB2 Tool

DB2 | UrPD| UPD| UPD| UPD| UPD| CMT UPD] CMT| UPD| UPD| UPD| UPD] CMT| UPD

UPD| UPD| UPD| CMT| UPD| UPD|] UPD

IMS | upp| upp| upp| upD| upD| cmT||::
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Agenda

“ Overview of Database Recovery Process
» What is Recovery?
» IBM Database Recovery Techniques

“ IMS Backup and Recovery Capabilities
» Log Management, DBRC |:|[|
» Backup, Recovery, Backout and Restart processes

“ Backup and Recovery Scenarios
» IMS Online
» IMS Batch

» Disaster Recovery
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IMS Backup and Recovery Capabilities

“ Log management
» From Log Archive to Problem Determination
" Backup process IMS Standard
» Take an Image Copy of the data Utilities
“ Database Recovery Control (DBRC)

» The Supervisor of Recovery Enh d with
nnancea wi

IMS Tools

» Keep track of logs, CAs, and ICs needed for recovery
“ Recovery process (forwards)
» Restore followed by apply of the after-image updates

“ Backout process (backwards)
» Remove the updates that cannot be committed

» Or remove the updates to a prior point-in-time (even committed ones)
“ Restart Process
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IMS Backup and Recovery Capabillities ...
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Database
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IMS Backup and Recovery Capabillities ...

“ Database Classification

» To adapt backup/recovery
procedures for each category

» DBRC Non-Recoverable DB

Full-function work databases

Index
DEDB with IMS V8

» Grouping of databases by
application importance

» Grouping of databases by volume

“ DBRC types of grouping
» For CA
CA Group
» For DBRC Commands

DBDS Group

» For IMS DB /STA, /STO, /DBR,
/DBD commands

DBDS Group
DB Group
Recovery Group
» For ORS and DRF Tools

Recovery Group
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IMS Log Management
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IMS Log Management ...

“ IMS Log data sets

» Contain all changes made to the data in the
database by an application program

Before image / After image

Commit status
“ Write Ahead Data Set (WADS)

» 1 or 2 actives
» Used by Log Write Ahead
“ Online Log Data Set (OLDS)
» Pool of 3 to 100 OLDS pairs
» Used in wrap-around mode
» Used in IMS restart
¥ System Log Data Set (SLDS)
» Archived OLDS or created by IMS Batch

» Used in IMS Restart if OLDS unavailable or with
Database Recovery

“ Recovery Log Data Set (RLDS)
» An option of the Archive process
» DB change information only

» Only used for Database Recovery

“ Performance and Integrity
» Log Write Ahead and WADS

Only complete log buffers written out
to OLDS

Incomplete buffers written out to
WADS when needed

“ Reliability
» Dual Logging
» Automated Archive
» Controlled by DBRC

“ Efficient space usage
» Log Compression (hardware)

» Non recoverable DB (option)
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IMS Log Management ...

“ Log Archive Utility (DFSUARCO)
» Archive one or several OLDSs to a single SLDS

Need “archive needed” status in DBRC
“ Log Recovery Utility (DFSULTRO)

» Correct errors in OLDSs, and batch or online SLDSs
» Close (CLS) or Duplicate (DUP) option

“ Log Merge utility (DFSLTMGO0)
» Merge of SLDS from two or more IMS systems

Start time and stop time
» Output used as input to the Log Transaction Analysis utility

» Not usable for DB recovery
“ Enhanced log formatting for problem determination
» Using IMS Problem Investigator for zOS Tool

» In Batch or with ISPF
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IMS Log Management ...

“ Change Accumulation Process

» Merge/Sort and Condense the DB updates in a streamline to allow efficient
recovery

Mandatory in a data sharing environment when using IMS standard Database
Recovery utility
Not needed if using IMS ORS or DRF Tool
» Using Database Change Accumulation utility (DFSUCUMO)

Can build one or more CA datasets from the same IMS Log(s)
As many jobs/steps as there are CA datasets
- Output of one job used as input of the following one

» Using IMS High Performance CA Tool

Multiple CA processes can run in parallel rather than in sequence
Single pass of each input log dataset

» Example of CA utilization
One single CA group for all DBDSs
Several CA groups, organized by volume or application
No CA group — CA run occasionally
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IMS Image Copy Solutions

“Image Copy Process
» To take a copy of the data in the database
» Clean versus Fuzzy

Clean, if no update at the same time. Consistent data guarantee
Fuzzy, if the database is still available for update. Log needed for the recovery.
» Dual copies to be sent on a remote site
“ Large Choice of Options
» Batch IC

Clean or Fuzzy (CIC)
» DFSMS Concurrent Copy, also called Image Copy 2

Using DFSMSdss DUMP
Clean or Fuzzy
» HSSP Image Copy option

» IMS HP Image Copy Tool — IC Function
Compressed / Stacked output / With Pointer Checking / Dynalloc
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IMS Image Copy Solutions ...

Image Copy Image Copy 2 Online IC HSSP Image Copy
(DFSUDMPO) (DFSUDMTO) (DFSUICPO)
Part of base IMS product Yes Yes Yes Yes
Execution Batch job Batch job Online Online (BMP)
(BMP)
Hardware requirement No Yes No No
Database data sets supported Full function and Full function | Full function | DEDBs only
DEDBs and DEDBs only
Fuzzy copies CIC option with Yes, without Yes, with Yes always
restrictions restrictions restrictions
- Fuzzy copies of KSDSs (HISAM, No Yes Yes
SHISAM, Index, PSINDEX)
- Data sharing with fuzzy copies Yes Yes No
Minimal database unavailability for No Yes No NA
clean image copies
Multiple data sets copied in one Yes Yes with IMS Yes no
execution \V/:]
Compressed output No Yes with IMS No No
V7
Pointer checking No No No No
Stacked output No No No No
Dynamic allocation No No No Yes
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IMS Image Copy Solutions ...

“Database Image Copy 2 Utility
(DFSUDMTO)

» Invokes DFSMSdss DUMP to create
copy of data set

» Can produce consistent (clean) or
concurrent (fuzzy) image copy

Clean image copy requires /DBR until

logical copy completes

Fuzzy image copy does not require
/DBR

» IMS database data sets supported
HDAM, HIDAM, HISAM, DEDB
OSAM, ESDS, KSDS

» Will produce 1-4 copies

2 copies registered with DBRC at
completion of DUMP

2 copies available for shipment offsite

» Multiple ICs to single output data set

Puiee

» Steps
1: /DBR for Clean. No /DBR for Fuzzy.
2: SMS completes Logical Copy.
3: /ISTA DB/AREA after Logical Copy done.

4: Appl attempts to update Track 4 before
Physical Copy done.

5: Controller saves copy of original track in
Side File Cache.

6: Appl modifies Track 4 on DASD.

7: Side File Cache offloaded to Host Side
File (Data space).

8: Controller merges tracks from
Cache/Host Side Files and DASD.

9: Physical Copy done

Enhanced with IMS V8

Copy multiple database data sets in one execution
Copy groups of DBDSs (e.g. DBDSGRP)
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IMS Image Copy Solutions ...

“HSSP Image Copy Option

»
»
»
»
»

Applies to DEDBs only

Creates fuzzy image copy during sequential processing of BMP
Eliminates need to read ADS twice

Reduces volume of log data needed for later recovery

Image copy already has latest updates
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IMS Image Copy Solutions ...

“IMS HP Image Copy Tool - Image Copy function
» Enhance the IMS Image Copy utility (DFSUDMPO)

For both Full Function DB, including HALDB and DEDB
Batch Image Copy or Concurrent Image Copy

v

Enable hash pointer checking during image copy

Not available with Concurrent Image Copy

Prereqs for full function databases
— IMS High Performance Pointer Checker

Prereqs for DEDB
— IMS Fast Path Basic Tools

Support compressed image copy output

Allow stacking of multiple output datasets

Reduced overall
elapsed time

Reduced tape
handling

Simplified JCL
especially if not
using GENJCL
function of DBRC

Allow copying of DBRC DBDS and CAGRP Groups
Can use Dynamic Allocation for input and output datasets

v v Vv Vv
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DBRC

“ Database Recovery Control (DBRC) Main Focuses
» Control the availability of resources needed in recovery process
Keep track of information necessary for DB recovery

» Control database access The Reposi‘ror'y
In non data sharing, or data sharing environment for Recovery
» Generate JCL for various IMS Ultilities Data

Data Base Recovery, Change Accumulation, Image Copy .
Log Archive, Log Recovery Th? gugegwsseor‘
“ RECON datasets ARG

» DBRC's primary resource Recovery

» Keep track of status for the IMS System and IMS Database activity

“ DBRC ISPF Frontend
» Using IMS DB Control Suite Tool
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DBRC ...

“ LIST.HISTORY Graphic Timeline

B2.070 03:30:25.0 LISTING OF RECON PAGE QBO&
- .- e e e = +
Timeline for DRDS: DIVNTIO4 DEHYSAMI] Ref
USID=00000001 AUTHORIZED=Q0000000 Fage
RECEIV E=00030000 HARD= 00008 008 A0az
+-Time—-—————————— +Events ——4+-—-—4--4+-o- - +
IC
REORG US|Subsystem
RE CoW C#& |ID|Logs and Allocs
Fe— e = = Femm— e ——— = -ttt -——_——_————— e e e e = +
81.111 12:00:00.0 IM51 aoa4
31.111 12:15:00.0 2 A aaa3
81.111 12:30:00.0 0O aoa3
01,111 12:45:00.0 s
31.111 12:59:5G.0 2 D
G91.111 13:00:00.0 5
31.111 13:15:80.0 3 A aaa3
81.111 13:59:59.9 3 D0
G91.111 14:00:00.0 C
g1.112 12:00:00.0 IM52 Goas5
31.112 12:15:00.0 4 & Qoo3
31.112 12:59:540.0 4 0
41.112 13:00:00.0 5
31.112 13:15:00.0 5 A aaa3
g1.112 13:59:59.0 5 D
31.112 14:00:00.0 C
+e——_————— e — — Fee————— — - -ttt -——— e —— — +
In the timeline, only the last digit of USID is shown.

IC: B = Batch, U = UIC, 0= 0IC, C = CIC, 5 =
Logs: S55I0 = Open time, T = Log Close,
v = ¥ol close, s = 05 claose
Allocs: D = Dealloc time, & = Alloc time

Stop
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IMS Database Recovery Solutions
“IMS Database Recovery utility (DFSURDBO)

»
»
»
»

Special IMS Batch Region

Recovers a single DBDS per execution
No HSAM or GSAM support

DBRC GENJCL.RECOV support

“IMS HP Image Copy Tool — Recovery Function

»
»
»

v v

Replace the IMS Database Recovery utility (DFSURDBO)
Recovers a single DBDS per execution

Accepts compressed (or normal) image copy

Needed to recover a DBDS from a compressed IC created by ICE
DBRC GENJCL.RECOV support
2 Operating Modes

Native mode
— Dynamic Allocation for input and output datasets

IMS Compatible Mode
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IMS Database Recovery Solutions ...

“ IMS Online Recovery Service Tool

» Online IMS used to recover IMS E EEEEEEEEEEEE——
databases .
The IBM High Performance
“ IMS Database Recovery Facility Tool DB Recover'y Solution

» Follow-on product to ORS V1
» Online or Batch Invocation

» Input data sets read in parallel Faster Recover-y Process

» DB data sets recovered in parallel .
» Recovery Time Options Parallel Processing

Recover to End of Logs
Time Stamp Recovery (Recovery

Single Log Pass

Point) _ CA not required
Point-In-Time Recovery (Arbitrary
Point) oo Neoded Timestamp Recovery to Any
- "Image Copy Needed" state is set :
in RECON for recovered Tlmes’ramp
databases after PITR

~ List of Open UOW DBRC Controlled
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IMS Database Recovery Solutions ...

Invocation DRF Master Subordinate
Choices Address Space Address Spaces
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Application Recovery for DB2 and IMS

“Simplify & coordinate the recovery of both IMS & DB2 data to a common
point, cutting the time & cost of data recovery and availability.
» Manage different DB2 & IMS logs and processes

» Synchronize DB2 & IMS logs to create a common point in time for recovering
data.

» Can be used to recover individual IMS or DB2 applications

“ISPF or Batch interfaces

“New name for DB2 Recovery Manager

Global View of Recovery

Object Management / Integrity / Automatisation




Application Recovery for DB2 and IMS ...
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“ Automated Management of Recovery Objects ART
» Generate JCL for ICs, CA, ... 1rst Function

» Create and merge ICs of DB2 and IMS data
» Delete obsolete objects (IC, CA, logs)

» Manage consistency between MVS catalog and DBMS repository (RECON dataset and DB2
catalog)

» Manage disk space
» Displays events occurring on the data

Application Recovery Tool -DB2 Primary Panel Application Recovery Tool -IMS Primary Panel

JCOMMAND ===> JCOMMAND ===>

1 FIC -Full Image Copy of one or more TS(s) 1 INIT -Update RECON for one or more DB(s)

2 IIC -Incremental Image Copy .. 2 IC -Physical Image Copy ..

3 MERGE -Merge Image Copies 3 CA -Change Accumulation ..

4 DELETE -Delete obsolete recovery objects .. 4 REORG -RECON data sets online reorg.

5 MDISK -List/Migrate/Delete .. 5 DELETE -Delete obsolete recovery objects ..
6 MDISK -List/Migrate/Delete ..
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Application Recovery for DB2 and IMS ...

“Create Data Consistency Point (optional)
» Called Virtual Image Copy (VIC) point
A point without update
Not a real IC
» Synchronous function

Dependent on application scheduling
Must occur before an update step

ART

2nd Function

» “Quiesce” point for selected IMS DBDSs and DB2 Tablesspaces
» Notification of the VIC point in the VIC RECON for this set of databases

Only noting the position of logs at a specific PIT
— Timestamp for IMS
- RBA for DB2

Only for Updated DBs
Much less than IC

Less DASD Resources
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Application Recovery for DB2 and IMS ...

“ Automate Recovery of Resources
» Parameter driven process
Generates JCL
» Automatic location of impacted DBs

Locates Image Copies and Logs
» Capability to automate the entire
process

Deallocation of databases

Archive of non-archived updates
Construction of the recovery JCL

Submission
Restart of databases

» Capacity to choose the VIC point earlier
to a specified timestamp

“ Provides many additional functions
to help in the recovery area

ART

3rd Function

IMS and DB2 - Primary Panel
COMMAND ===»

1VIE - Yirtual Image Copy on DB{s)/TS(s)
2 Hap - Map one or mare OB(s)/T3(s)

IRECOV - Recovar on one or more DB{s)/TS(s)
4 CHECK - Chack data on one or mare T5(s)
& Aop - Automatic Operator Program

//SBOTH EXEC PGM=DRMEXEC, DYNAMNBR=50, REGION=2M,

// PARM= (FUNCTION, 'DRMRECOV', IMID, 'IMSG',DB2ID, 'DB2G')

ART

+++
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Application Recovery for DB2 and IMS ...

MVS
Catalog

Recovery
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Application Recovery for DB2 and IMS ...

“ Execution Environment
» Batch

//S1 EXEC PGM=DRMEXEC, DYNAMNBR=50, REGION=2M,
// PARM= (FUNCTION, ’' Funcname’ { ,Name,’'Value’ })
//SYSIN DD *

Parameters of the requested function

» or ISPF
“ ART Parmlib

JCL generation skeletons
Description of the IMS or DB2 site

Definition of several environments
Default processing parameters for various functions

Standard CLIST of the product
ISPF panels
Members that allow execution of SQL statements

v v

v v v Vv
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IMS Backout Solutions

“ Dynamic Backout
» Automatically performed by IMS online when

An application program terminates abnormally

An application program issues a rollback call, or tries to access an unavailable
database

A deadlock occurs
» Also available for IMS Batch under specific conditions
DASD logging, IMS Pseudo-Abend, BKO=Y parameter

IMS Batch Backout Manager Tool to have consistent BKO
“ Dynamic Backout during IMS Emergency Restart

» NOBMP option prevent dynamic backout of BMPs

» COLDBASE option stops dynamic backout of everything
“IMS Batch Backout
» To the last checkpoint for BMPs and IMS Batch in a sharing environment

» To any checkpoint for an IMS Batch in a non-data sharing environment using
CHKP control statement

'. L ®0 '
@Pullee ...
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IMS Batch Backout Process

“IMS Batch Backout utility (DFSBBO00)

» Removes changes in the database which were made by a specific failing
program.

» Uses the PSB used by the program whose effects are to be backed out.
» Alog data set is created during the backout process.

“IMS Batch Backout Manager Tool
» For customers running IMS stand-alone batch work
» Automatically ensures that abended batch programs get backed out

Immediately after failure (if MVS environment still available)
Or at restart time (if not done at abend time)
» Ensures that batch logging is done
replace logs specified in job's JCL
adds logs if not specified
» Requires no changes to existing JCL

» Complements IMS Program Restart Facility Tool

' ¢ ®0
@Pullee .
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IMS Program Restart Process

“IMS Standard Restart process
» IMS Application Extended Checkpoint/Restart facilities

» For stand-alone batch and BMP

“IMS Program Restart Facility Tool
» Enhances IMS Application CHKP/RST facilities
Help to restart a job at the correct checkpoint
ISPF Panels to administer abended jobs
» Enables restart
on any system in sysplex
without specifying a checkpoint Id

PRF

Easy and quick
restart of abended
batch and BMP jobs
without JCL change

on any IMS in an
IMSplex

Less restart errors

and "time consuming

and costly” recovery
activity

without overriding the JCL with the correct log data set name(s)
» Can be used to restart programs that do not abend but which end with a non-zero

return code

'. L ®0 '
@Pullee ...
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IMS Tools for Backup and Recovery - Summary

“ Backup
» IMS HPIC Copy Function
“ Change Accum

» High Performance Change
Accum

“ Database Recovery
» IMS HPIC Recovery Function
» Online Recovery Services
» Database Recovery Facility
» Index Builder
For index recovery
» IMS HP Pointer Checker

For Database validation
“ Application Recovery

» Application Recovery for DB2

and IMS

“ Batch Backout
» Batch Backout Manager
“ Program Restart
» Program Restart Facility
“ Recovery Management
» IMS DB Control Suite
» IMS Problem Investigator
» IMS Performance Analyzer

Data .
nagement ~
Tools ”

Ma
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Agenda

“ Overview of Database Recovery Process

» What is Recovery?

» IBM Database Recovery Techniques
“ IMS Backup and Recovery Capabilities

» Log Management, DBRC

» Backup, Recovery, Backout and Restart processes
“ Backup and Recovery Scenarios

» IMS Online |:|[|
» IMS Batch

» Disaster Recovery
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IMS Online - 1/O Errors

“IMS manages Database 1/O Errors
“ Write Errors

» IMS application program are NOT aware of a DB write error!
» IMS Tasks performed

EEQE created
IMS buffer for the erroneous block/Cl allocated
Log record created

» Restored by online warm or emergency restart

» Not retrieved thru IMS Batch Process

» DBRC can help in maintaining Database Integrity!

each EEQE recorded in the DBDS record
“ Read error

» AO status code to the application
» EEQE created for the data in error
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IMS Online — Application Program Abend

“ Abending online programs
» Automatic back-out by the online system using the log records
From WADS, OLDS, or SLDS
» Correct the problem that caused the abend

» Restart Transaction / Program by IMS /START command

“ Abending Dependent Region
» Correct the problem that caused the abend
» Restart Transaction / Program by IMS /START command
» Restart BMP from the Latest Checkpoint
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IMS Online Failure

“ Different Situations
» MVS System Failure

» Control region Failure
» System Data Set Failure, including Message Queue datasets

“IMS Emergency Restart
» Perform all the tasks needed to get a consistent state for IMS resources

» By reading the IMS logs

» For UOW where IMS is the Syncpoint Manager (coordinator)

IMS system pilots the backout/commit of the pending UOW.
IMS communicates with the other Resource Manager (participant).
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IMS Online Failure ...

“Incomplete IMS Emergency Restart
» Selective “Cold Start” possible

COLDCOMM or COLDBASE for a DBDC system
COLDSYS for a DBCTL system
» Affected Database stopped and flagged in DBRC (if registered)

“ Before Cold Start
» Reestablish MANUALLY database integrity
» Validate the logs using Log Recovery utility (DFSULTRO)
» For FF DBs, IMS Batch Backout utility (DFSBBOO0O0)

to back out programs (PSBs) that were active at the time of failure
» For DEDBSs, Forward recovery of all updated DEDBs

Quick solutions to bring the DEDBs to a consistent state
- |IBM Tool: DEDB Fast Recovery
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IMS Online Failure in a Data Sharing Environment

“ IMS Fast DB Recovery Implementation
» Function included in IMS

» To avoid Lock Contention on IMS DB Resources owned by the failing IMS

“ IMS Emergency Restart
» Still needed ASAP to complete recovery

“ IMS Emergency Restart Failure
» Cold Start required
» Before Cold Start
Reestablish MANUALLY database integrity
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IMS Online - IMS and DB2 Resources

“ Environment:

» IMS Online System as Syncpoint Manager

For workload running as IMS transaction or BMP

» IMS TM/DB and DB2 as Resource Managers
“ Integrity Management

» Using Two Phase Commit Protocol

» To maintain consistency between several kinds of data
“ Main Issue for BMP window

» Recover IMS and DB2 databases to a consistent state

To an “equivalent” timestamp
Stored in the IMS RECON for IMS
Stored in the DB2 SYSIBM.SYSCOPY for DB2

» Create backup/ICs that are usable to recover

» Application Recovery for DB2 and IMS Tool can help in creating Timestamp for
Timestamp Recovery

» IMS ORS/DRF can perform Point-In-Time Recovery to any timestamp.
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IMS Batch Failure

“ Application Program with or without checkpoint/restart logic
» Backout needed to leave the data in a consistent state
» Job restartable after backout
To any checkpoint or to the beginning
» With or without DBRC
“ Option 1 — Manual Backout and Manual Restart
» Steps
Close current batch SLDS
Run batch backout utility
» Remarks:

SLOW manual process

Reaction time to initial abend

JCL preparation and submission
Scope for errors causing further delay
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IMS Batch Failure ...

“ Option 2 — Backout using IMS Batch Backout Manager Tool

» IMS provides automatic backout under specific conditions. The tool provides
automatic backout in any cases.

» Batch Backout control dataset (BBDS) used to save information needed in the
event of an unexpected termination of backout process

» BBM functions executed whenever an IMS Batch application abends.

“ Option 2 — Restart using IMS Program Restart Facility Tool
» Make sure the abended job run under BBM control
BCMO001I CKPTID TRACKING IS ACTIVE message in the job log
» Performs backout functions
» Then application restart begins

Easier with IMS Program Restart Facility

Automatically supports IMS Extended Restart by supplying the correct
CHKPTID without JCL Changes

'. L ®0 '
@Pullee ...
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IMS Batch - Appli.Logic Error with IMS and DB2 Updates

“ Application Logic Error in a Batch Environment
» The program completes successfully.
IMS and DB2 updates are performed
» Not an application abend, followed by backout which leave the data in a consistent state
“ Option 1 — Recovery / Reprocess
» Steps:
Recover the data to some previous point of consistency
Correct the application program
Replay the work
» Remarks:
All the work following the Batch is lost.

Not doable in an online environment where many transactions have been processed on
many databases after this batch application error

“ Option 2 — Manual Changes
» Steps:
Edit/Correction of the data
» Remarks

High Risk
Log analysis tool required
DB2 Log Analysis Tool / IMS Problem Investigator
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IMS Disaster Recovery

“ Tactics
» Daily or Weekly Backup with/without a quiesce of all update activity
Truck or electronic transfer of recovery data

- Secondary ICs
- Secondary logs, CA datasets

» Remote logging

IMS Remote Site Recovery
— Log data sent in real-time as transaction are being processed

— Asynchronous transmission The Ideal View
» Remote Copy

DASD Synchronous Remote Copy — IBM PPRC

— Limited distance Recovery with No Loss of
- No data loss Data

— Impact on the local system
DASD Asynchronous Remote Copy — IBM XRC

- Using System Data Mover No Impgc’r on Prod.
— Minimal data loss Environment

Minimal Cost




